
Open Language Tools 
XLIFF Translation 

Editor

Version 1.4.0 (PISA Mods)

User Manual



Table of Contents
1 Introduction..................................................................................................... 1
2 Installation....................................................................................................... 2

2.1 System Requirements.............................................................................. 2
2.2 Download................................................................................................. 2
2.3 Starting Installation on Windows..............................................................2
2.4 Starting Installation on Unix and Mac OS X.............................................. 3
2.5 Installation wizard steps.......................................................................... 3
2.6 Technical Support.....................................................................................4

3 First Steps with the Editor................................................................................ 5
3.1 Starting the Editor................................................................................... 5
3.2 Translator IDs........................................................................................... 5
3.3 Starting Work on a New Project................................................................5

3.3.1 The .xliffeditor directory................................................................. 7
3.4 Understanding the application................................................................. 8

4 Starting to Translate...................................................................................... 10
4.1 Editing Segments................................................................................... 10
4.2 Editing Translated Segments..................................................................11
4.3 Editing Source Language Segments.......................................................11
4.4 Handling Tags........................................................................................ 11

4.4.1 About Tags................................................................................... 11
4.4.2 Tag Protection.............................................................................. 11
4.4.3 Working with the Tag Verification Tool..........................................12

5 Segment related information and attributes.................................................. 13
5.1 Segment Status..................................................................................... 13
5.2 State Qualifier (Translation Type)........................................................... 13
5.3 Commenting on Segments.....................................................................14

5.3.1 Adding a Comment...................................................................... 14
5.3.2 Editing Comments........................................................................ 15
5.3.3 Deleting Comments..................................................................... 15

5.4 Source Context Information................................................................... 16
6 Handling Matches.......................................................................................... 17

6.1 The Match Window.................................................................................17
6.2 Transferring Matches..............................................................................18
6.3 Updating of Formatting Information in Matches..................................... 19

7 Navigation Options........................................................................................ 22
7.1 Quick Navigation....................................................................................22
7.2 Status-based Navigation........................................................................ 22

8 Working With Projects and Mini-TMs............................................................... 25
8.1 Creating and Saving Mini TMs................................................................ 25
8.2 Handling of internal repetitions and fuzzy matches...............................25
8.3 Handling of updates during a project life-cycle...................................... 25
8.4 Working with the Autopropagate option.................................................26
8.5 Duplicate Source Segment Entry Check.................................................26
8.6 Maintaining Mini-TMs..............................................................................28
8.7 Merging Mini-TMs................................................................................... 28

9 Spell Checking............................................................................................... 32
9.1 Installing Spell Checking Tools............................................................... 32
9.2 Configuring Spell Checking.................................................................... 32
9.3 Working with the Spell Checking Tool.....................................................34

10 Handling XLIFF files........................................................................................36
10.1 Commenting on Files............................................................................. 36
10.2 Printing XLIFF files................................................................................. 37

10.2.1 Print Options................................................................................ 37
10.3 Splitting and Merging Large XLIFF Files..................................................39

10.3.1 Splitting Files................................................................................ 39
10.3.2 Merging Files................................................................................ 40

11 The GUI in Detail............................................................................................ 42



11.1 GUI Elements......................................................................................... 42
11.1.1 The Toolbar.................................................................................. 42
11.1.2 The Status Bar............................................................................. 43
11.1.3 The Menus....................................................................................44

11.2 Customizing the GUI.............................................................................. 50
11.3 Hotkeys and Shortcuts........................................................................... 50
11.4 Customizing Shortcuts........................................................................... 52

12 Appendix....................................................................................................... 54
12.1 Common Translation Process................................................................. 54
12.2 Attribute Information............................................................................. 54
12.3 1:1 and M:N matches............................................................................. 57
12.4 Dealing with SGML Marked Sections...................................................... 58

12.4.1 What is a Marked Section?........................................................... 58
12.4.2 Which Marked Sections Show Up in the Editor?............................58

12.5 The Structure of .xlz Files ...................................................................... 58
12.6 Back-Converting .xlz Files...................................................................... 59

12.6.1 Using custom Unicode to Entity mapping for SGML.....................61



1 Introduction

Welcome to the new version 1.4.0 of the Open Language Tools XLIFF Translation Editor (in 
short OLT), a Java application developed by Open Language Tools project. This editor is 
designed to allow the reading and editing of XLIFF files. 
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2 Installation

2.1 System Requirements
OLT is build on the Java™ platform. The PISA version of OLT is compatible with Windows, 
including Window XP, Windows Vista and Windows 7 and 8.

The recommended hardware and software requirements which should be met in order to 
guarantee satisfactory use of the Open Language Tools XLIFF Translation Editor are as fol-
lows:

• Pentium IV, Athlon XP (or better) processor

• 512 MB RAM

• 1024 x 600 screen resolution or higher

• approx. 100 MB hard disk space for a full installation:

• 11 MB for Open Language Tools XLIFF Translation Editor

• 56 MB for spell checker (per language)

• Java 2 Runtime Environment, Version 1.5.0 (or higher) for installation

• Windows 98, 2000, XP, Vista, 7 or 8

Please make sure that a Java Runtime Environment version 1.5.0 or higher is properly 
installed and configured for your operating system. This is necessary to install the soft-
ware.

You can obtain the JRE from this URL: http://www.oracle.com/us/technologies/java/standard-edi-
tion/overview/index.html 

2.2 Download
Downloads for current versions of OLT are on the PISA Portal. The file is located in the doc-
ument repository, in

PISA 2015 Documents → Materials → 2015 Field Test Resources → Translation → OLT

The file to use for installation is named 

transeditor_v1_4_0_pisa_mod_1_1_win.jar

Download this file and run it by double-clicking on it. This will launch the OLT installation 
program. You must have Java installed in order to run the installer.

2.3 Installation wizard steps

Step 1

The Welcome dialog appears. Click on the Next button.

Step 2

License agreement is displayed. Please carefully read the license. 

If you agree to the license select “I accept the term of this license agreement” and click 
on the Next button. 

If you do not agree to the term of the license, the installation will be aborted.
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Step 3

The Select the installation path dialog appears. You are asked to select the path at which 
the editor should be installed. You can do so by clicking on the Browse button. The default 
path is:

%ProgramFiles%\OLT_PISA_MOD on Windows,

The Select Components dialog appears. You are asked to select the components you wish 
to install. All components are selected by default. The available components are as fol-
lows:

• Open Language Tools XLIFF Translation Editor (mandatory)

• Spellchecker

When your selection is complete, click on Next button.

Step 1

The Pack installation progress dialog appears. You can see the installation progress of 
each of the components you selected and the overall installation progress. After installa-
tion of the packs, click on Next button.

Step 2

The Setup Shortcuts dialog appears. You may select to create shortcuts on your desktop 
(Unix) and in your Start or Program Menu. Select the Programgroup where you want the 
shortcuts to be created and click on Next button.

Step 3

The translation editor Installation Completed dialog appears informing you that the 
installation of the translation editor is now complete. To finish the editor installation, click 
on Finish button.

You are now ready to start the editor. To start the editor, please refer to section 3.1 Start-
ing the Editor.
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3 First Steps with the Editor

3.1 Starting the Editor
Once you have installed the editor, you can start the application as follows:

• Windows

• Select the Open Language Tools XLIFF Translation Editor program folder from the 
Windows Start -> Programs menu.

or

• Open Explorer, go to the location of the editor as specified during the installation 
and double-click on the translation.bat file.

• Unix

• Go to translation editor installation directory and run translation.sh.

• Mac OS X

• Do as for the Unix installation

or

• Rename the translation.sh file to translation.command and double-click it.

3.2 Translator IDs
Each time you start the editor, you are asked to enter your translator ID (see Fig. 1). This 
translator ID will be used when entering segments into the mini-TM. Your translator ID 
may be no longer than five characters in length.

The editor will always remember the last translator ID used during the last editor session 
and will display this ID automatically in the Translator ID dialog when the editor is restar-
ted.

For more information on translator IDs and how they are used, please see the section 8 
Working With Projects and Mini-TMs. To change your translator ID you must restart the 
editor, as this dialog appears only when a new editor session is started.

3.3 Starting Work on a New Project
Before you start work on a new translation project, it is necessary to create a new project 
in the editor. Go to File -> New Project. The New Project dialog appears (see Fig. 2). In the 
Project Name field enter the name of the new project e.g. Solaris. The project name may 
be no longer than twenty-five characters in length and may not contain the underscore 
( _ ) character. Then select the source language and target language you will be working 
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on and click on OK. It is possible to create multiple projects with the same name if the 
language combinations are different.

When you start the editor for the first time, no project is selected. However, once you 
have created a project, the project last selected or created will always be loaded auto-
matically each time you start the translation editor. The title of the project currently 
selected always appears in the title bar of the application.

If you wish to open another already existing project, close any XLIFF file which may be 
open in the editor. Then go to the File - Open Project menu. The Open Project dialog 
appears (see Fig. 3).
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In the Project List field you can select a project from the drop down list of existing pro-
jects. Click on OK to load the project. 

You can now go to the File - Open menu. The Open dialog appears. Here you can select 
the XLIFF file you wish to open. If the XLIFF file you select does not contain the same lan-
guage combination as the selected project, you will receive the following error message 
when you try to open it:

The language combination in this file does not match the language combination in  
the selected mini-TM. Please select a different mini-TM.

You must then select an XLIFF file with the same language combination as the project or 
select or create a project with the same language combination as the XLIFF file.

Note: It is not possible to create a new project or open an existing one while an 
XLIFF file is open in the editor. To create a new project or open an existing 
one, you must first close the XLIFF file.

3.3.1 The .xliffeditor directory

Open Language Tool XLIFF Translation Editor creates a directory called .xliffeditor in your 
home directory when you first create a project. That directory will contain a number of 
files including a sub-directory called mini-TM that contains all the mini TMs that you have 
created (see 8.1), the HTML output of the Print command (see 10.2) as well as a number 
of temporary files.

On Windows, the .xliffeditor directory is located here:

C:\Documents and Settings\<user-name>\.xliffeditor

On Mac OS X, it is located here:

/Users/<user-name>/.xliffeditor

where <user-name> is the name of the user running the editor.

On Unix based systems, it is located here:

$HOME/.xliffeditor.
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3.4 Understanding the application
When an XLIFF file is opened in the editor for the first time, three windows are visible - 
two vertically parallel windows and a third horizontal window at the bottom of the screen 
(see Fig. 4).

The two vertical windows are the source and target language windows, while the hori-
zontal window is the match window. (For details on how to change the default window 
arrangement, please see the sectionCustomizing the GUI). The source text appears in the 
source language window on the left-hand side while the target text (i.e. the translation) 
appears in the target language window on the right-hand side. Menus and a toolbar are 
visible at the top of the screen, while a status bar is visible at the bottom. The currently 
active segment is highlighted in the source and target language windows.

The text in the source language window is write-protected by default, while the text in the 
target language window can be edited. All translations are entered in the target language 
window. All tags appear in red and are write-protected. However, this tag protection can 
be switched off if necessary (see the section Tag Protection). The source and target lan-
guage windows are synchronized. This means that if you click on a segment in the source 
or target language window, the corresponding segment in the other window is automatic-
ally highlighted too. 

By default, scrolling in either window occurs independently of the other window. This 
allows you, for example, to retain your position in the target language window while 
searching for text in the source language window. However, the menu option Synchron-
ized Scrolling in the Options menu allows you to synchronize scrolling so that both 
windows scroll together.

The blue square icons which appear on the left-hand side of the source and target lan-
guage windows indicate the start of a new segment. A segment usually corresponds to a 
sentence, heading, listitem, caption, etc. The icon in the source language window indic-
ates the status of the translation, i.e., Untranslated, Translated, or Approved while the 
icon in the target language window indicates the translation type, i.e., Untranslated, User 
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Translation, 100% Match, Fuzzy Match, or Autotranslation. (For more information on seg-
ment status and translation types, see the sections Segment Status and State Qualifier
(Translation Type).)

The match window displays any matches available for the currently active segment. This 
window displays the source language string and its corresponding translation as found in 
the TM database or embedded in the XLIFF file. The text in the match window cannot be 
edited. For more information on the match window see the section 6 Handling Matches.

The source and target language search fields which are visible beneath the toolbar, are 
used to search for text in the source and target language windows respectively.
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4 Starting to Translate

4.1 Editing Segments
When you open an XLIFF file in the editor for the first time, you will see that the first seg-
ment in the source language window and the first segment in the target language window 
are automatically highlighted. You may see that some of the segments in the target lan-
guage window have already been translated. These translations are 100% matches which 
were found by some automated tools to prepare your translation. If a fuzzy match has 
been found for a segment, it will appear in the match window when you click on the seg-
ment in the source or target language window. For details on working with matches see 
the section 6 Handling Matches. If no matches are available for a segment, the match 
window will be empty, and the segment must be translated by overwriting the segment in 
the target language window.

For empty translations that also have no match, it is often helpful to fill in the source lan-
guage string before you start translating. You can easily do this by using Edit – Copy 
Source. The default shortcut for this is Alt+Ins. To clear the target, you can use Edit – 
Clear Target or Alt+Del.

Each time you have completed the translation of a segment, it is important that you mark 
the segment as translated using one of the following options.

1.Confirm and Translate Next

This option is available in the Edit menu and in the right-click mouse button menu or by 
using the shortcut Alt+Enter. This option performs the following three actions:

• Marks the current segment as translated.

• Updates the mini-TM with the source language segment and its target language 
translation.

• Brings you to the next untranslated segment. If the next untranslated segment con-
tains only tags or untranslatable text, it will be marked automatically as translated. 
If there is already an exact match for the next untranslated segment in the mini-TM, 
this segment will be autotranslated (assuming the Autopropagate option in the 
Options menu is switched on). The editor will not stop until it reaches the next 
untranslated segment which does not contain only tags or untranslatable text or for 
which there is no exact match in the mini-TM. 

2.Mark Segment As Translated

This option is available in the Edit menu and in the right-click mouse button menu or by 
using the shortcut Alt+1. It performs the following two actions:

• Marks the current segment as translated.

• Updates the mini-TM with the source language segment and its target language 
translation.

However, it does not bring you the next untranslated segment.

It is recommended that you use the first option described above to mark segments as 
translated, as it is the more efficient and useful option.

4.2 Editing Translated Segments
It is possible to edit segments which you have already marked as translated. You do not 
need to mark the segment as untranslated, then edit it and then mark it as translated 
again. Instead you can simply edit the text as required. To update the contents of the 
mini-TM it is important that once you have finished editing the segment, you select Tools - 
Update Mini-TM or click on the Update Mini-TM icon in the toolbar (default shortcut is 
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Ctrl+U). Otherwise, the modified translation will not be entered into the mini-TM, and it 
will not appear as a match should this segment occur again later on in the same file or in 
another file in the same project. Instead the older version of the translation will appear in 
the match window.

As the source segment already exists in the mini-TM, when you update the mini-TM with 
the modified target language segment, the Duplicate Source Segment Entry Check will be 
invoked. This check function will ask if you wish to add the modified segment to the mini-
TM as part of a new segment pair or if you wish to overwrite the old target language seg-
ment with this new modified target language segment. For more information on this 
feature, please see the section Duplicate Source Segment Entry Check.

4.3 Editing Source Language Segments
Normally you should not need to edit any source language segments. It is not advisable 
to do so unless otherwise requested, as by editing the source language text you may 
affect the leveraging rate for future projects.

However, there are some cases where it may be necessary to edit the source language 
text. For example, if a minor change is made to the original English files, it may be ineffi-
cient to process the files again through preparation tools. Instead, it may be easier to 
apply the change in the source language segment in the XLIFF file and replicate this 
change in the corresponding target language segment.

The source language window of the editor is write-protected by default. But it is possible 
to switch off the write-protection in the unlikely event that you need to edit the source 
language text. This is done by clicking on Source Write Protection in the Options menu. 
The check box beside the menu option indicates whether write protection is switched on 
or off.

4.4 Handling Tags

4.4.1 About Tags

Tags are components that are often used to outline certain words (or phrases) in a text. 
You surely come across tags while translating HTML or content from any markup based 
file (like XML).

Tags a usually enclosed in angle brackets and have an opening tag, content and a closing 
tag( i.e. <b>bold text</b> or <item type=”menu”>File – Open</item>). In most cases, 
the tags need to be kept unchanged in the translation, but the content has do be trans-
lated.

To quickly transfer all the tags from source to target, you may use Edit – Copy Source 
Tags or Alt+Shift+Insert.

4.4.2 Tag Protection

All tags are protected by default. It is unlikely that you will need to delete or change a 
tag. However, if this is necessary it is possible to switch off the tag protection in the 
Options menu or by using the shortcut Alt+P. It is advisable to switch the tag protection 
back on as soon as you have finished editing tags, to ensure that tags are not edited or 
deleted accidentally.

4.4.3 Working with the Tag Verification Tool

The tag verification tool is invoked by using Tools - Tag Verification option or by clicking 
on the Tag Verification icon in the toolbar. 

The tag verification tool searches the source language for tags, segment by segment, and 
verifies that the tags in the source language segment match the tags in the correspond-
ing target language segment in number. By default, it also checks that the tags occur in 
the same order as in the source language. However, it is possible to change this by click-
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ing on Options - Ignore Tag Order. If this is switched on, only the number of tags will be 
approved, not the order in which they occur. This option is useful in the case of some lan-
guages where the order of the tags is often reversed in translation.

As the source language window is write-protected, it is always assumed that the source 
language tags are correct. If tags have been added to the target language segment or are 
missing from the target language segment, the following dialog window appears inform-
ing you that the tags in that segment do not match.

If you click on Correct Manually, the dialog will close and the cursor will appear in the 
segment where the tags do not match. If you click on Ignore and Continue the tag veri-
fication tool will continue to check the remaining segments.
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5 Segment related information and attributes

5.1 Segment Status
Each segment in the editor is assigned a status depending on whether or not it has been 
translated or approved. The status is denoted by the blue square icon which appears at 
the start of the source language segment. The segment status is controlled by the user. 
I.e. you can change the status of a segment at any time. The following describes the dif-
ferent status types.
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 Untranslated

All segments which have not yet been translated either automatically (by the TM tool) or 
manually (by the translator) are marked as untranslated. The icon denoting this status is 
a minus sign (-) on a blue square which appears at the start of the segment in the source 
language window. When a XLIFF file is opened in the editor for the first time, all segments 
for which there is no 100% match available will be marked as Untranslated. An untrans-
lated segment can be marked as translated but not as approved. 
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 Translated

All segments which have been translated either automatically (by the TM tool) or manu-
ally (by the translator) are marked as translated. The icon denoting this status is a plus 
sign (+) on a blue square, which appears at the start of the segment in the source lan-
guage window. A translated segment can be marked as untranslated or as approved.
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 Approved

Approved segments are translated segments which have been reviewed and approved by 
a reviewer. This use of this status type is optional. The icon denoting this status type in 
the source language window is a check mark on a blue square which appears at the start 
of the segment.

A segment marked as approved cannot be edited. However, it is possible to change the 
status type back to translated, in which case the translation can be edited again. Only 
translated segments can be marked as approved. An approved segment cannot be 
marked as untranslated. It must first of all be marked as translated and then as untrans-
lated.
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 Rejected

Rejected segments are translated segments which have been reviewed and rejected by a 
reviewer. The use of this status type is optional. The icon denoting this status type in the 
source language window is an red “X” on a blue square which appears at the start of the 
segment.

Only translated segments can be marked as rejected. A rejected segment cannot be 
marked as untranslated. It must first of all be marked as translated and then as untrans-
lated.

5.2 State Qualifier (Translation Type)
There are different State Qualifiers depending on how a segment has been translated. 
The State Qualifiers is denoted by the icon at the start of the target language segment. 
The State Qualifiers is controlled by the editor, i.e. you cannot change the translation type 
directly.
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 Untranslated

All segments which have not yet been translated either automatically (by the TM tool) or 
manually (by the translator) are marked as untranslated. The icon denoting this status is 
a minus sign (-) on a blue square which appears at the start of the segment in the target 
language window. When a XLIFF file is opened in the editor for the first time, all segments 
for which there is no 100% match available will be marked as untranslated. Also, if a 
source language string does not need to be translated in the target language, when you 
mark the segment as translated, the Status Qualifier of this segment will be untranslated. 
However, the segment status will be translated. (Of course, this assumes that you have 
not modified the segment in any way.)
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 100% Match

This refers to segments for which a 100% match was found in the translation database. 
These segments are automatically marked as translated when the XLIFF file is opened. 
The icon denoting this type of translation in the target language window is '100' on a blue 
square which appears at the start of the target language segment. The segment status of 
such segments is always translated.
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 Fuzzy Match

When a fuzzy match is transferred to the target language window, the icon at the start of 
the target language segment changes to the fuzzy match symbol. However, this icon 
changes to a user translation icon as soon as you modify the fuzzy match in any way.
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 User Translation

This refers to segments which you have translated either from scratch or by modifying a 
fuzzy match. The icon denoting this type of translation in the target language window is a 
pen symbol on a blue square which appears at the start of the segment. As soon as you 
modify the target language segment by editing text in this segment, the icon changes to 
the user translation icon. Also, if the translator transfers a fuzzy match from the Match 
window to the Target Language window and modifies the fuzzy match in any way, the 
fuzzy match icon will immediately change to the user translation icon.
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 Autotranslation

This refers to segments which have been translated automatically from the mini-TM. For 
more details on autotranslated segments, please see the section Working with the Autop-
ropagate Option. The icon denoting this type of translation in the target language window 
is the same as the 100% match icon, except the icon is rotated 90 degrees.

5.3 Commenting on Segments
It is possible to add comments to individual segments in the XLIFF file. Once a comment 
has been created, it can be edited or deleted at any time.

Note: Normally these comments are not included in the file after it is back-conver-
ted to its original format and therefore do not need to be deleted from the  
XLIFF file prior to back-conversion.

5.3.1 Adding a Comment

To add a comment to a segment which does not already have a comment associated with 
it, go to the Edit menu and select Comment on Segment- Add Comment or press 
Ctrl+Alt+N. If a comment has already been attached to the segment, this option will be 
grayed out. A dialog box (see Fig. 6) appears entitled Comment on segment no. X where 
X is the number of the current segment.

Here you can enter a comment of unlimited length. If there are multiple people working 
on the file, you may wish to use the date stamp feature when you have finished typing 
your comment. By clicking on the Date Stamp button, your translator ID which you 
entered at editor start-up and today's date are automatically entered into the comment 
dialog. When you have finished entering your comment, click on the Save button to save 
the comment and then on the Close button to close the comment. Alternatively, you may 
click on the Close button. You should then be asked if you wish to save the comment. 
Once you have closed the comment dialog, you will notice that a comment icon (  ) 
appears below the translation type icon of the segment (see Fig. 7). This indicates that a 
comment has been added to this segment.
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5.3.2 Editing Comments

To edit a comment, you can either double-click on the comment icon (  ) which appears 
below the translation type icon. Alternatively, you can click on the segment to which the 
comment is attached, then go to the Edit menu and select Comment on Segment- Edit  
Comment (default shortcut Ctrl+Alt+B). If no comment is attached to the segment, this 
menu option will be grayed out. The Comment dialog box (see Fig. 7) appears. Here you 
can edit an existing comment or add a new comment.

5.3.3 Deleting Comments

To delete a comment, there are two possibilities. The simplest approach is to go to the 
Edit menu and select Comment on Segment-Delete Comment (default shortcut 
Ctrl+Alt+M). You will be asked if you are sure that you want to delete the comment. If 
you click on Yes, the comment will be deleted and the comment icon will disappear from 
the start of the segment. Alternatively, you can double-click on the comment icon (  ). 
The Comment dialog box (see Fig. 7) appears. Here you can simply delete the comment 
by highlighting the comment text and deleting it. If you then save and close the comment 
dialog, the comment icon will disappear from the start of the segment. 

5.4 Source Context Information
In some situations, the translator needs to know, in which context the current segment is 
used. When translating software, this might be the precise location of a dialog element or 
menu item.

Some XLIFF files contain this additional information, which describes the context of the 
source language text, depending on how the original XLIFF file was generated. If this 
information is available, the translator can view it using the Source Context option in the 
View menu. Selecting this option will pop up a window that includes any source context 
information that is associated with the segment currently highlighted in the editor. To hide 
this dialog, simply toggle the Source Context menu item.

Note: If the XLIFF file doesn't contain any context information, the Segment ID will  
be displayed in this window. The ID is also displayed right on top of the status  
bar.
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6 Handling Matches

6.1 The Match Window
The match window (see Fig. 8) is located at the bottom of the editor's user interface. It 
indicates any alternative translation stored in the XLIFF file or the match or matches 
found for a segment mini-TM of the Translation Editor. Each time you click on or navigate 
to a segment, the match window is updated with the matches found for that segment. If  
no matches appear in the match window, no matches were found for that segment.

The match window displays the following segments in the following order:

• new source language segment

• matching source language segment found in the database

• matching target language segment found in the database.

Using color highlighting, the editor displays the differences between the new source lan-
guage segment and the matching source language segment found in the database. Three 
different colors are used depending on the type of difference involved. 

The use of the three different colors is explained as follows:

White: Replaced text.

Example

New Src: This is Solaris 9.

Old Src: This is Solaris 8.

Blue: Inserted text.

Example

New Src: The network is surely the computer.

Old Src: The network is the computer.

Grey: Removed text.

Example

New Src: The network is the computer.

Old Src: The network is surely the computer.

Note: Moved text is currently not highlighted in the editor. 
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Hard returns which have been inserted, removed or replaced are highlighted as a thin 
vertical line. Spaces which have been inserted, removed or replaced are highlighted as a 
thick vertical line.

Match information is displayed in the status bar for each match. This information is as fol -
lows:

TM: Indicates that an alternative translation has been stored in the current XLIFF file by 
some Translation Memory tool. If the name of the TM tool is available in the XLIFF file, it 
will be displayed.

Mini-TM: If the match was found in the mini-TM, the name of the mini-TM is displayed. The 
name of the mini-TM corresponds to the name of the project currently loaded.

Format Difference: This is the percentage difference in terms of formatting between the 
new source segment and the match source segment found in the database. If the tags in 
the new source segment are identical to the tags in the match source segment, the 
format difference will be 0%.

Quality: This is the percentage similarity between the new source segment and the match 
source segment found in the database. This quality value takes formatting and textual 
information into account. The quality rating ranges from 75% to 100%. Matches below 
75% in quality do not appear in the match window.

Example 1

New Src: The network is the computer.

Old Src: <b>The network is the computer.</b>

Format difference: 4%

Quality: 96%

Example 2

New Src: The network is surely the computer.

Old Src: The network is the computer.

Format difference: 0%

Quality: 96%

Example 3

New Src: The network is surely the computer.

Old Src: <b>The network is the computer.</b>

Format difference: 4%

Quality: 90%

In the above example, the 10% difference is due to a 4% difference in formatting and a 
6% difference in textual content (due to the addition of the word 'surely'). 

6.2 Transferring Matches
It is not possible to edit text in the match window. If you wish to modify the text displayed 
in the match window, click on the Transfer 1:1 or Transfer M:N button, depending on 
whether the match is a 1:1 or M:N match. This transfers the selected target language 
match to the target language window where it overwrites the corresponding source lan-
guage segment(s). The match can then be edited in the target language window so that it 
matches the corresponding source language segments(s) in the source language window.
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If there are multiple matches available for a segment, it is possible to scroll through the 
matches using the scrollbar in the match window and to select the preferred match by 
clicking on it. Multiple matches are displayed in order of quality, starting with the highest 
quality match. The first match is automatically highlighted for selection. If only one match 
is available, this match is automatically highlighted for selection. If multiple 100% 
matches have been found for a segment, the first match found will appear in the target 
language window. However, all matches found will appear in the match window. There-
fore, it is possible to select a different match from the match window, then click on the 
Transfer 1:1 or Transfer M:N button and transfer the selected match to the target lan-
guage window, where the originally selected 100% match will be overwritten.

6.3 Updating of Formatting Information in Matches
When a match is copied over from the Match window using the Transfer button and the 
Update Tags option in the Options menu is switched ON, the formatting of the proposed 
translation is modified if necessary so that it matches or at least closely resembles the 
formatting of the new source translation. In other words, the editor updates the transla-
tion with the formatting from the new source segment. When establishing whether or not 
the formatting matches, the name of the tags and the number of tags are taken into con-
sideration. The position or order of the tags are not considered, as this can vary 
depending on the word order of the different languages.

If you do not wish the tags to be updated when a match is transferred to the target lan-
guage window, switch OFF the Update Tags option in the Options menu.

Example 1

New Src: The sky is <b>blue</b>. 

Old Src in LRD: The sky is blue. 

Old Trg in LRD: Der Himmel ist blau. 

Result if Update Tags option is switched 
on: Der Himmel ist blau.<b></b> 

Result if Update Tags option is switched 
off: Der Himmel ist blau.

If the new source segment contains formatting, and the old source and target segments 
do not, the proposed translation includes the tags from the new source segment. Obvi-
ously, the editor will not know where to put this formatting. That is why it appends it to 
the end of the segment.

Example 2

New Src: The sky is blue. 

Old Src in LRD: The sky is <b>blue</b>. 

Old Trg in LRD: Der Himmel ist <b>blau</b>. 

Result if Update Tags option is switched 
on: Der Himmel ist blau. 

Result if Update Tags option is switched 
off: Der Himmel ist <b>blau</b>.

If the new source segment contains no formatting and the old source segment and its 
translation do, the formatting is removed from the translation when it is transferred to the 
match window.
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Example 3

New Src: The sky is <b>blue</b>. 

Old Src in LRD: The <i>sky</i> is <b>blue</b>.

Old Trg in LRD: Der <i>Himmel</i> ist <b>blau</b>.

Result if Update Tags option is switched 
on Der Himmel ist <b>blau</b>.

Result if Update Tags option is switched 
off: Der <i>Himmel</i> ist <b>blau</b>.

If the old source and target segments contain a superset of the tags contained in the new 
source segment, then the additional tags are removed from the translation when it is 
transferred to the match window.

Example 4

New Src: The <i>sky</i> is <b>blue</b>.

Old Src in LRD: The sky is <b>blue</b>.

Old Trg in LRD: Der Himmel ist <b>blau</b>.

Result if Update Tags option is switched 
on:

Der Himmel ist <b>blau</b>.<i></i>

Result if Update Tags option is switched 
off:

Der Himmel ist <b>blau</b>.

If the new source segment contains a superset of the tags contained in the old source and 
target segments, then the additional formatting from the new source segment is appen-
ded to the end of the proposed translation.

Example 5

New Src: The sky is <b>blue</b>.

Old Src in LRD: The sky is <b>blue</b>.

Old Trg in LRD: Der <i>Himmel</i> ist blau.

Result if Update Tags option is switched 
on: Der Himmel ist blau.<b></b>

Result if Update Tags option is switched 
off: Der <i>Himmel</i> ist blau.

If the formatting in the old source is identical to the formatting in the new source seg-
ment, but the formatting in the old target segment is different to the formatting in the old 
source segment, it can be assumed that the formatting differences in the old target seg-
ment are intentional, and so the formatting from the old target is retained in the result 
translation.

Example 6 

New Src: The sky is <b>blue</b>.

Old Src in LRD: The <u>sky</u> is <i>blue</i>.

Old Trg in LRD: Der Himmel ist blau.

Result if Update Tags option is switched 
on: Der Himmel ist blau.<b></b>
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Result if Update Tags option is switched 
off: Der Himmel ist blau.

If however, the formatting in the old source segment is not identical to the old target seg-
ment or the new source segment, and the formatting in the old target segment and the 
new source segment are not identical either, the formatting is updated to match the new 
source segment. 

Example 7

New Src: The sky is <b>blue</b>.

Old Src in LRD: The <u>sky</u> is <i>blue</i>.

Old Trg in LRD: Der Himmel ist <b>blau</b>. 

Result if Update Tags option is switched 
on: Der Himmel ist <b>blau</b>.

Result if Update Tags option is switched 
off: Der Himmel ist <b>blau</b>.

Lastly, if the formatting in the old target segment matches the formatting in the new 
source segment but does not match the formatting in the old source segment, the format-
ting in the old target sentence is retained in the result translation.
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7 Navigation Options

7.1 Quick Navigation
If you wish to navigate from one segment to the next, click on the icon at the start of any 
segment and then use the up and down arrow keys on your keyboard to move from one 
segment to the next or previous segment. If the cursor is positioned within the text in a 
segment and you use the arrow keys, the cursor will move from one line to the next 
within the segment (if the segment consists of multiple lines).

You may also quickly navigate to the top or bottom of the current XLIFF file by using 
either the Navigation menu or the Ctrl+Home or Ctrl+End shortcuts. You can also nav-
igate page by page throguh your file with the Page Up and Page Down keys.

In case you nee to quickly go to a certain segment and the segment number is known, 
use Navigation – Go To Segment or press Ctrl+G and enter the segment number.

7.2 Status-based Navigation
You can use the navigation aid in the toolbar or the Next Segment and Previous Segment 
options in the Navigation menu to go from one untranslated segment to the next or from 
one autotranslated segment to the next etc. The navigation option in the Navigation 
menu changes dynamically depending on the selection in the toolbar. Therefore, to go 
from one untranslated segment to the next, it is necessary to select Untranslated in the 
navigation aid in the toolbar and then go to Navigation - Next Untranslated. If you select 
100% match in the navigation aid in the toolbar, when you go to the Navigation menu, 
you will see that Next Untranslated has changed to Next 100% Match.

Alternatively, you can select Untranslated, 100% Match etc. in the toolbar and use the up 
and down arrow icons in the toolbar to navigate from one segment to another. Default 
shortcuts for previous and next are Ctrl-Up and Ctrl-Down

The different navigation options are explained as follows.

NEXT

Autotranslated Brings you to the next segment which has been marked as auto-
translated.

segment status = translated,
translation type = autotranslated

Untranslated Brings you to the next segment for which there is no 100% 
match available and which has not yet been translated.

segment status = untranslated,
translation type = untranslated

100% Match Brings you to the next segment which has been translated using 
a 100% match.

segment status = translated
translation type = 100% match

Fuzzy Match Brings you to the next segment for which a fuzzy match is avail-
able and for which no 100% match is available.

segment status = untranslated,
translation type = untranslated

User Translation Brings you to the next segment which has been modified by you, 
the user.

translation type = user translation
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Translated Brings you to the next segment which has been marked as 
translated.

segment status = translated

Approved Brings you to the next segment which has been marked as 
approved.

segment status = approved

Rejected Brings you to the next segment which has been marked as rejec-
ted.

segment status = rejected

Previous

Autotranslated Brings you to the previous segment which has been marked as 
autotranslated.

segment status = translated,
translation type = autotranslated

Untranslated Brings you to the previous segment for which there is no 100% 
match available and which has not yet been translated.

segment status = untranslated,
translation type = untranslated

100% Match Brings you to the previous segment which has been translated 
using a 100% match.

segment status = translated
translation type = 100% match

Fuzzy Match Brings you to the previous segment for which a fuzzy match is 
available and for which no 100% match is available.

segment status = untranslated,
translation type = untranslated

User Translation Brings you to the previous segment which has been modified by 
you, the user.

translation type = user translation

Translated Brings you to the previous segment which has been marked as 
translated.

segment status = translated

Approved Brings you to the previous segment which has been marked as 
approved.

segment status = approved

Rejected Brings you to the previous segment which has been marked as 
rejected.

segment status = rejected

Two additional navigation options are listed in the Navigation menu. They are:

• Next Multiple 100% Match

• Previous Multiple 100% Match

When the XLIFF file is opened in the editor, the first 100% match found is automatically 
inserted into the target language window, and the segment is marked as translated. How-
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ever, you may find in the case of segments for which multiple 100% matches were found, 
that the first 100% match is not always the most suitable match. To verify if the best 
100% match has been selected, you can select Next Multiple 100% Match or Previous 
Multiple 100% Match to jump to the next or previous segment for which more than one 
100% match exists. You can then view the different matches and decide which is the most 
suitable. If the second or third match is more suitable, you simply select the preferred 
match and click on Transfer 1:1 to overwrite the target language segment in the target 
language window.
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8 Working With Projects and Mini-TMs

8.1 Creating and Saving Mini TMs
When you create a new project what you are essentially doing is creating a new mini-TM. 
The mini-TM is a file-based TM database which is used for storing work in progress. It has 
two purposes:

• to handle internal repetitions and fuzzy matches

• to handle updates during a project life-cycle

When you create a mini-TM file, a file with the name projectname_XX_YY.MTM (XX being 
the source language and YY the target language) is created in the Mini-TM directory (see 
3.3.1).

The .MTM file contains all of the translations created by the translator in the editor.

The contents of the Mini-TM are stored only in memory until the mini-TM is saved for the 
first time. Once the mini-TM has been saved once, a physical Mini-TM file is created in the 
Mini-TM directory. 

For performance reasons, the Mini-TM file is not saved automatically by the autosave 
function. However, it is saved automatically when you change to another project, create a 
new project and when you shut down the editor. In addition, each time you close a XLIFF 
file you will be asked if you wish to save the Mini-TM. You then have the choice of clicking 
on Yes or No. If you click on Yes the mini-TM will be saved in its current state. If you click 
on No, the latest changes you have made to the Mini-TM will be retained in memory and 
will not be written to the physical .MTM file. However, you will not lose any data. It is 
recommended that you always choose Yes when asked if you want to save the Mini-TM 
file.

Note: It is very important that you save the Mini-TM file regularly by selecting File -  
Save Mini-TM.

8.2 Handling of internal repetitions and fuzzy matches
Internal repetitions and fuzzy matches refer to multiple occurrences of the same or sim-
ilar segments within the same file or within the same project. Each time the translator 
marks a segment as translated using the options Mark as translated or Confirm and 
Translate Next, the source segment and its translation are stored in the mini-TM. If an 
identical or similar segment occurs later on in the same file or in another file in the same 
project, the translation in the mini-TM will be used as a match for this segment. Fuzzy 
matches from the mini-TM are displayed in the match window when you click on the seg-
ment. How 100% matches are displayed is determined by the autopropagate option. For 
further details, please see the section Working with the Autopropagate option.

8.3 Handling of updates during a project life-cycle
During a project, there may be several updates to the files being translated. In such 
cases, it is important that translators create a mini-TM by creating a project. Otherwise 
the work they have done on the preceding version of the files would be lost.

When you receive an updated version of the files in a project, you simply load the project 
(mini-TM) which you created for the preceding version and then start translating the 
updated XLIFF files as normal. By selecting the mini-TM you will be able to benefit from 
the translation work you did on the preceding version of the files. Fuzzy matches from the 
mini-TM are displayed in the match window when you click on the segment. How 100% 
matches are displayed is determined by the autopropagate option.
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Note: In the current version of the editor, the mini-TM is not networkable.

8.4 Working with the Autopropagate option
The autopropagate option can be switched on or off in the Options menu. The autop-
ropagate option influences the way in which 100% matches from the mini-TM are 
provided to you. The following explains what happens when the autopropagate option is 
switched on and what happens when it is switched off. Of course, this assumes that a pro-
ject has already been created or selected.

If the autopropagate option is switched off

If you translate a segment and an identical segment occurs later on in the same file or in 
another file in the same project, the translation of the previous segment will appear in the 
match window with a match quality of 100%. The TM name in the status bar will indicate 
that the match is from the mini-TM i.e. the TM name will be the same as the project name.

If you receive updated files and if the project from the previous version is selected, 
whenever you encounter a segment in the new version of the files which you have 
already translated in the preceding version, the translation will appear as a match in the 
match window with a match quality of 100%. The TM name in the status bar will indicate 
that the match is from the mini-TM i.e. The TM name will be the same as the project 
name.

If the autopropagate option is switched on...

If you use Confirm and translate next to navigate from one segment to the next, the 
editor will jump to the next untranslated segment. It will then check the mini-TM to see if 
it contains a 100% match for this segment. If so, it inserts the translation into the target 
language window, thereby overwriting the source language segment, marks the segment 
as translated and gives it the translation type autotranslated. It then jumps to the next 
untranslated segment and checks the mini-TM again to see if has been translated. The 
editor continues to work in this way until it reaches an untranslated segment for which no 
100% match is available in the mini-TM.

In addition, if you click on an untranslated segment with your mouse or navigate to it 
using one of the navigation options, and there is a 100% match available for this segment 
in the mini-TM, the translation of this segment will be inserted automatically into the tar-
get language window. The segment will be marked as translated and given the translation 
type autotranslated.

As of version 1.2.0 of the OLT XLIFF editor, automatic translation is offered while opening 
the file if any 100% matches are found in mini-TM which can be applied to any of the seg-
ments. The user is asked regardless of autopropagate option.

8.5 Duplicate Source Segment Entry Check
The duplicate source segment entry check is invoked whenever you try to enter a source 
segment into the mini-TM which is already in the mini-TM, but with a different translation. 
The following are three situations in which this could occur:

The autopropagate option is switched off.

You translate a segment, mark it as translated and an identical segment occurs again 
later on in the same file or in another file belonging to the same project. However, you 
decide to translate the second occurrence of the segment differently to the first occur-
rence and not use the 100% match in the match window. When you mark the second 
occurrence of the segment as translated, the Duplicate Source Segment Entry Check dia-
log will appear.
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The autopropagate option is switched on.

You translate a segment, mark it as translated and an identical segment occurs later on in 
the same file or in another file belonging to the same project. As the autopropagate 
option is switched on, the second occurrence of the segment is autotranslated. However, 
you decide to edit the translation or replace it with a completely new translation. The seg-
ment is already marked as translated. Therefore, you cannot use Confirm and Translate 
Next to enter the new translation into the mini-TM. So you select Options-Update Mini-TM 
to enter the modified translation into the mini-TM, and the Duplicate Source Segment 
Entry Check dialog will appear (see Fig. 9).

You translate a segment, mark it as translated and then modify the translation.

The segment is already marked as translated. Therefore, you cannot use Confirm and 
Translate Next to enter the new translation into the mini-TM. So you select Options-Up-
date Mini-TM to enter the modified translation into the mini-TM, and the Duplicate Source 
Segment Entry Check dialog will appear (see Fig. 9).

In this dialog you will be told that the source language segment already exists in the mini-
TM but with a different translation. The following options are available to you:

Add

If you click on Add the source and target language segments will be added again as a new 
segment pair to the mini-TM i.e. the old segment pair will remain in the mini-TM. However, 
the most recently entered segment pair will appear first in the list of matches should a 
similar or identical source language segment occur again in the .xlz file.

Overwrite

If you click on Overwrite the old target language segment will be overwritten by the new 
target language segment i.e. the old target translation will be deleted from the mini-TM.

Cancel

If you click on Cancel the dialog is closed, and no actions are performed. 
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8.6 Maintaining Mini-TMs
The Mini-TM Maintenance Tool allows you edit the currently selected mini-TM and to per-
form global search and replace operations in this mini-TM. To access this tool, you must 
ensure that no XLIFF file is open in the editor. To use the maintenance tool, go to Tools - 
Maintain Mini-TM. The Mini-TM Maintenance Tool dialog appears (see Fig. 10).

Here you can scroll through the entire contents of the mini-TM which is currently loaded. 
All segments are displayed in source and target language pairs. To edit a source or target 
language segment, simply insert your cursor at the position in the segment which you 
wish to modify and make the necessary modifications.

It is also possible to perform a search/replace operation on the entire contents of the 
mini-TM. To do this, simply click on the Search/Replace button. The standard 
Search/replace dialog appears.

When you have finished making modifications to the contents of the mini-TM, click on the 
Save button, and all your changes will be saved. To close the Mini-TM Maintenance Tool 
click on the Close button.

Any changes you have made to the mini-TM in this way will be reflected in the Match win-
dow in the editor GUI when working on XLIFF files belonging to the same project.

As of version 1.2.0 of the OLT XLIFF editor,it’s possible to merge a TMX file to the mini-TM. 
To do so, press Import TMX button and select an TMX file. Note that only segments with 
correct source and target languages will be imported. Other segments will silently be 
dropped.

As of version 1.2.0 of the OLT XLIFF editor, it is possible to search, copy and paste text 
from mini-TM while an XLIFF file is open. To search, copy/paste text from mini-TM, go to 
Tools menu and select Search mini-TM option.

8.7 Merging Mini-TMs
It is possible to merge two or more mini-TMs to create one larger mini-TM. This feature is 
particularly useful when there are multiple updates during a project lifecycle. When a new 
update arrives, the project manager (for example) can collect all the mini-TMs for a partic-
ular language from the different translators who worked on the first project hand-off. The 
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project manager can then merge all of these mini-TMs to form one large mini-TM which 
contains all of the translations from the different translators. The larger mini-TM can then 
be sent to the translators and used when translating the updated files. In this way, each 
translators working on the project can benefit from other translators' work.

The editor function which allows you to merge mini-TMs is called the Mini-TM Merge Tool 
and is found in the Tools menu.

To merge two or more mini-TMs, go to Tools - Merge Merge Mini-TMs. The Merge Tool 
Options dialog appears (see Fig. 11).

Step 1

In the Project Name field you enter the name of the new project or mini-TM you wish to 
create. You then select the source and target language for which the mini-TM will be used. 
Obviously, the source and target language you select should correspond to the source 
and target language of the mini-TMs you wish to merge. Then click on the Next button.

Note: If you start the Mini-TM Merge Tool while a XLIFF file is open in the editor, it 
will not be possible to select a different source and target language combina-
tion to the combination used in the XLIFF file. To be able to choose a different 
language combination, you must first close the XLIFF file.

Step 1

In the next dialog (see Fig. 12), you are asked to select the mini-TMs you wish to merge. 
This is done by clicking on the Add button. A file browser window appears in which 
only .MTM files for the specified language combination appear. Click on one of the mini-TM 
files which you want to merge and then click on Open. The mini-TM name appears in the 
Mini-TMs window in the Merge Tool Options dialog. You repeat this for each Mini-TM which 
is to be merged. When you have finished selecting the Mini-TMs to be merged, the names 
of all the selected Mini-TMs should appear together in the Mini-TM window in the Merge 
Tool Options dialog, in the order in which they were selected. 
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Step 2

In a separate Translator IDs window, which also appears in the Merge Tool Options dialog, 
all the translator IDs used in the selected Mini-TMs are listed once. If necessary, you can 
switch the order in which these IDs are listed by clicking on the ID and then clicking on 
the Move Up or Move Down buttons. This order of the translator IDs is important if the 
Mini-TMs are to be merged using semi-automatic or automatic mode, as explained in the 
next step.

Step 3

The merge process can be conducted in three different modes which are displayed in the 
Merge Tool Options dialog. These modes determine how the merge tool behaves when it 
encounters duplicates. Duplicates are segment pairs where the source segments are 
identical but the target translations are different. These modes are mutually exclusive 
and are explained as follows.

Manual

Manual mode means that whenever duplicate source segments with different target 
translations are encountered, the merge tool asks you to select the preferred translation. 
For this option, the order of the translator IDs in the Merge Tool Options dialog is irrelev-
ant, as the tool always asks you which translation you prefer whenever the source 
segments are identical and the target translations are different. 

Semi-automatic

Semi-automatic mode means that whenever duplicate source segments with different tar-
get translations and identical translator IDs are encountered, the merge tool asks you to 
select the preferred translation.

The difference between manual mode and semi-automatic mode is that in semi-automatic 
mode the tool takes the decision for you if the target translations and translator IDs are 
different. This decision is based on the order in which the translator IDs are listed in the 
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Translator IDs window in the Merge Tool Options dialog. This order determines which 
translator's translations have preference over other translators' translations. If the source 
segments are identical but the target translations and translator IDs are different, the tool 
does not stop to ask you for your opinion. Instead, it simply selects the segment pair with 
the translator ID which comes first in the Translator IDs list. 

However, if the source segments and the translator IDs are identical but the target trans-
lations are different, the tool will ask you to choose the preferred translation. 

Automatic

Automatic mode means that the tool takes all decisions for you when it encounters 
duplicate source segments. The difference between automatic and semi-automatic mode 
is that if the source segments are the same, the translator IDs are the same, and the tar-
get translations are different, the tool simply selects the first translation it finds. 

For this mode, as in the case of semi-automatic mode, the order in which the translator 
IDs are listed in the Merge Tool Options dialog is important, as it determines which trans-
lator's translations have preference over other translators' translations. If the source 
segments are identical, the target translations are different, and the translator IDs are 
different, the tool does not ask you for your opinion. Instead, it simply selects the transla-
tion from the translator whose ID comes first in the Translator IDs list. 

The following table shows clearly the differences between manual, semi-automatic and 
automatic mode. Obviously, it is assumed in all cases that the source segments are 
always identical. Otherwise, the segments would not be classed as duplicates.

Manual Semi-Automatic Automatic

Different target translations

Different translator IDs

Ask user Automatic - Use 
translator ID list to 
determine which 
translation to use.

Automatic - Use trans-
lator ID list to 
determine which 
translation to use.

Different target translations

Same translator IDs

Ask user Ask user Automatic - Pick first 
segment pair.

Step 4

Once you have selected the desired mode, click on Start. If you are not using Automatic 
mode and duplicate segments are found, a window pops up listing all the available trans-
lations for a segment and the translator ID of the translator who created each translation. 
To select your preferred translation, simply click on the translation and click on Add. If 
there are further duplicates, the same window appears again asking you to select your 
preferred translation.

Step 5

The merge tool merges the Mini-TMs, and once the merge process is complete, a dialog 
appears stating 

The selected Mini-TMs have been successfully merged.
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9 Spell Checking

9.1 Installing Spell Checking Tools
The Open Language Tools XLIFF Translation Editor is able to use several command line 
spell checking tools, such as ASpell or Hunspell.

These tools are part of (or available for) the most open source based Linux or OpenSolaris 
distributions. To install the spell checking engine and corresponding dictionaries, please 
refer to the software management tools of your distribution.

The full installation package of OLT comes along with a bundled  version of ASpell 
provided under the terms of the LGPL agreement. ASpell version 0.50.3 is used in the Sol-
aris version of the editor, and ASpell binary version 0.33.5 is used in the Windows version. 
When installing the editor, you are asked if you wish to install dictionaries for French, 
Italian, German, Spanish and/or Swedish. The spell checking tool will work only if one or 
more of these dictionaries has been installed and only if the target language of the XLIFF 
file currently open in the editor matches the target language of one of the dictionaries 
installed.

If you are not working on Linux and don't use the full installation package, you may down-
load and install spell checking tools and dictionary separately. We recommend using 
Hunspell, as this is under active development and has some advanced features for non-
English languages. You may obtain hunspell binaries and dictionaries from the project's 
main site at http://hunspell.sourceforge.net/.

9.2 Configuring Spell Checking
The quality of spell checking strongly depends on the tools, dictionaries and options you 
use. You can configure all the options by using Options – Spellchecker Options (see Fig.
13).

The default spellchecker is Aspell. 
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Note: Currently (OLT 1.4.0) you cannot add other spell checkers. This option will be  
available in future versions. Anyway – you can just change the “Aspell com-
mand” to use other spellchecker (e.g. hunspell). A good command line for  
hunspell is hunspell -a -d ${TRANS_PROJECT_LANG}

OLT uses a simple command line interface to interact with existing spellcheckers. The 
command that is used to invoke the spellchecker can be changed at the Aspell command 
field. The full command is composed of the command name (normally aspell or 
hunspell) followed by the option -a (which is used to establish direct communication 
between OLT and the spellchecker) and the --lang= (-d for hunspell) option to set the 
language for spellchecking.

If the spellchecker is not installed in the search path of your system, you need to preceed 
the command with the full installation path (e.g. /opt/hunspell_1.2.8/hunspell or 
c:\program files\hunspell_1.2.8\hunspell).

Setting the spell checker language

As you may work on several project with different target languages, you need to tell the 
spell checker the language to use. Two placeholders are available for this purpose. The $
{PROJECT LANG} placeholder will pass the language code of your current translation pro-
ject directly to  to the spell checker. This works well if the dictionaries for the given 
language are available.

In some cases it might happen, that no dictionaries that fit your project's language set-
tings are available. Often this is the case if you translate to special flavors of a language 
(like Canadian English). As workaround you can define language mappings. To define such 
a mapping, click on Add in the Language Mapping table window. Now select the Project 
language from the list (Canadian English) and enter the language code for the 
spellchecker to use (en_US) in the Spellchecker language field. 

Note: You can define multiple mappings at the same time.

To use such a mapped language, use the ${TRANS_PROJECT_LANG} placeholder in the 
Aspell command field.

Testing spell checker options

You can test your spell checker command by using a system shell. Just open a system 
shell (or command line) window and enter the Aspell command without the -a option. You 
need to replace the placeholders with a current value. If the spellchecker command is 
invoked, you can type some text. The spellchecker will check every line and report a * for 
correct words and lines starting with & for errors (see Fig. 15). 

End your input with Ctrl+D to leave the spellchecker.

39



9.3 Working with the Spell Checking Tool
To call the spell checking tool, go to Tools - Spell Checking (default shortcut F7) or click on 
the Spell Check icon in the toolbar. If the spell checking tool does not recognize a word 
in the target language file, the Spelling Checker dialog will appear (see Fig. 15).

In the Not in Dictionary window, you will see the word which was not recognized by the 
spell checking tool.

In some cases, the spell checking tool may make suggestions as to how these words 
should be spell. These suggestions are listed in the Suggestions field. To apply one of the 
listed suggestions, click on the preferred suggestion and then click on Change. The mis-
spelled word in the target language window is replaced by the selected suggestion. If you 
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click on Change All, all occurrences of the same word in the current XLIFF file will be 
replaced.

If none of the suggestions made by the spell checking tool is correct, you may correct the 
word yourself by editing the word in the Not in Dictionary field and clicking on Add. This 
action also adds the word to the spell checker dictionary so that it will be recognized next 
time it occurs.

If the word not recognized by the spell checker tool is in fact a valid word, you may click 
on the Ignore button to skip over this word and continue checking the rest of the file. You 
may also click on the Ignore All button which ignores all further occurrences of this word 
in the file. 
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10 Handling XLIFF files

10.1 Commenting on Files
It is possible to enter comments on the XLIFF file as a whole. These comments are not 
linked to any particular segment. They are associated with the XLIFF file which is currently 
open in the editor and are written into this file.

Note: These comments are not included in the file after it is back-converted to its  
original format and therefore do not need to be deleted from the .xlz file prior  
to back-conversion. 

Adding Comments

To add a comment to the XLIFF file, go to the Edit menu and select Comment on File. A 
dialog box (see Fig. 16) appears entitled Comment on File. Here you can enter a comment 
of unlimited length. If there are multiple people working on the file, you may wish to use 
the date stamp feature when you have finished typing your comment. By clicking on the 
Date Stamp button, your translator ID which you entered at editor start-up and today's 
date are automatically entered into the comment dialog. When you have finished enter-
ing your comment, click on the Save button to save the comment and then on the Close 
button to close the comment. Alternatively, you may click on the Close button. You 
should then be asked if you wish to save the comment. 
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Editing Comments

To edit a comment, go to the Edit menu and select Comment on File. The Comment on 
File dialog appears (see Fig. 16). All comments on the file are displayed here. You can edit 
the text here as you would edit text in a standard text editor. To save your changes, click 
on the Save button. 

Deleting Comments

To delete a comment, go to the Edit menu and select Comment on File. The Comment on 
File dialog appears (see Fig. 16). All comments on the file are displayed here. To delete 
some or all of the content, simply highlight the content you wish to delete, and delete the 
highlighted text as you would delete text in a standard text editor.

10.2 Printing XLIFF files
To print a XLIFF file, go to the File menu and select Print. A dialog appears informing you 
that the XLIFF file will be exported to HTML and opened in a window of your default 
browser. If you click on OK, Open Language Tool XLIFF Translation Editor will attempt to 
open the HTML file in Netscape (on Solaris) or Internet Explorer (on Windows). If neither of 
those browsers are present on your system, you can still find the HTML file in the .xliffed-
itor directory (see 3.3.1). Open it with your favorite browser and  use the print option in 
your browser to print the file.

10.2.1 Print Options

Before you print a file from the editor, you can choose from a selection of print options 
the format you would like the print-out to take. These print options can be accessed in the 
File menu by clicking on Print Options. The Print Options dialog appears (see Fig. 17).

In the Languages tab you can choose from the following options:
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Source and Target Language

This option prints the source and target language segments, with each segment appear-
ing on a new line. This is the default option and appears as follows:

This is source segment 1.

This is target segment 1.

This is source segment 2.

This is target segment 2.

etc.

Source Language Only

This option prints the source language segments only, with each segment appearing on a 
new line. The format is as follows:

This is source segment 1.

This is source segment 2.

etc.

Target Language Only

This option prints the target language segments only, with each segment appearing on a 
new line. The format is as follows:

This is target segment 1.

This is target segment 2.

In the Tags tab you can choose from the following options:

With Tags

This option displays all tags in the print-out. This is the default option and appears as fol-
lows:

This is <b>source</b> segment 1.

This is <b>target</b> segment 1.

etc.
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Without Tags

This option does not display any tags in the print-out e.g.

This is source segment 1.

This is target segment 1.

etc.

Abbreviated Tags

This option displays only the abbreviated form of all tags in the print-out (i.e. only the first 
character of each tag will appear in the print-out) e.g.:

This is <source< segment 1.

Dies ist <target< segment 1.

etc.

In the Other tab you can choose from the following options:

Show Translation Type

You can click on a check box to switch on or off this option. The default setting is OFF. If 
this option is switched on, a tag will appear at the start of each segment indicating the 
translation type of the segment in question. The tags used are as follows:

100% match <100> 

Untranslated <UNT> 

User Translation <USE> 

Autotranslation <AUT> 

Fuzzy Match <FUZ>

This print-out appears as follows:

<100> This is <b>source</b> segment 1.

<100> This is <b>target</b> segment 1.

<USE> This is source segment 2.

<USE> This is target segment 2.

etc.

Show Segment Number

You can click on a check box to switch on or off this option. The default setting is OFF. If 
this option is switched on, the segment number will appear at the start of each segment. 
The print-out appears as follows:

1 This is <b>source</b> segment 1.

1 This is <b>target</b> segment 1.

2 This is source segment 2.

2 This is target segment 2.

etc.

Obviously, the different options in the different tab dialogs can be combined in different 
ways to give different results. For example, the most detailed print-out available would 
appear as follows:
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1 <100> This is <b>source</b> segment 1.

1 <100> This is <b>target</b> segment 1.

2 <USE> This is source segment 2.

2 <USE> This is target segment 2.

etc.

In this print-out, the segment number, the translation type, the source and target lan-
guage segments and all tags are displayed. If you do not modify the print options before 
printing a file, the options last selected will be applied.

10.3 Splitting and Merging Large XLIFF Files

10.3.1 Splitting Files

The Editor has a function to split large XLIFF files into smaller chunks. There are a number 
of reasons why you would want to do this. Perhaps you would like a number of translators 
to work on one very large file simultaneously. Alternatively, for very large files, the 
machine running the Editor, may not have enough memory to process the file.

The XLIFF file splitting tool is invoked by selecting the Tools - Split XLIFF File option. This 
brings up the following dialog box:

This dialog has four input fields. The first field allows you to specify the input file to be 
split. Clicking on the '...' button beside this field will allow you to browse for a file. Only 
XLIFF files will be selectable.

The second field allows you to specify a piece of text to appear in the names of the output 
files. This allows the output files to be easily identified. The splitting tool generates names 
for the output files from four parts. These are:

1.The name of the file being split, with the .xlz or .xlf extension removed.

2.The suffix specified in the second field.

3.The position that the file in question has in the sequence of files.

4.The file extension (either .xlz or .xlf).

The third field specifies the maximum number of translation units to include in each of 
the output files.

The last field allows you to specify the directory where the output files are to be placed.
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When the fields are filled in and the OK button is selected, the tool splits the large XLIFF 
file into a number of smaller files where each of the smaller files has the number of trans-
lation units specified in the third field (or less in the case of the last file output).

Note: .XLZ files output by the splitting tool are not fully valid .XLZ files. Each of the 
output files contains the skeleton file data for the entire unsplit file, i.e., all  
the block level formatting, such as <para> tags. Because of this the split files  
will not back convert correctly. They have to be merged together first.

10.3.2 Merging Files

After all the split files have been processed with the editor they can be merged back 
together using the Merge Tool. This can be accessed by selecting the Tools - Merge a split 
XLIFF File option. Selecting this option brings up the following dialog box.

This dialog box also has four fields. The first field allows you to specify the directory 
where the files to be merged reside. The '...' button allows you to browse for the input dir-
ectory.

The second field allows you to specify the directory to output the merged file. The '...' 
button allows you to browse for the output directory.

The third field specifies the filename of the original file. This field will be used to name the 
output file. It will also be used, in conjunction with the input in the fourth field to determ-
ine which files, from the input directory, need to be merged together. This can be done, 
as the names of the files to be merged contain the original file's name.

The fourth field is used to specify the suffix used when the files were split.

When the four fields are filled in and the OK button is selected, the tool merges the input 
files into one large XLIFF file. This file can be back converted, if it is a .xlz file.
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11 The GUI in Detail

11.1 GUI Elements

11.1.1 The Toolbar

The toolbar contains the following functions (from left to right):

Open File

Opens a file browser dialog from where you can select the .xlz file you wish to open.

Save File

Saves the .xlz file currently open in the editor.

Undo

Undoes the last editing action.

Redo

Redoes the last editing action if 'undo' has been used previously.

Copy

Copies the text currently highlighted in the editor.

Paste

Pastes the text previously copied or cut at the current current position.

Cut

Removes the text currently highlighted in the editor and copies it to the clipboard.

Search

Opens the Search/replace dialog.

Navigation Options

Selects the segment status or translation type you wish to navigate to. For more informa-
tion on this, please see the section Navigation Options.

Down Arrow

Brings you to the next segment with the type or status selected in the navigation options.
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Up Arrow

Brings you to the previous segment with the type or status selected in the navigation 
options.

Confirm and Translate Next

Marks the current segment as translated, updates the mini-TM with the source and target 
language strings in that segment and brings you to the next untranslated segment.

Approve and Go To Next Translated

Marks the current segment as approved and brings you to the next translated segment. 
(Only translated or rejected segments can be marked as approved.)

Reject and Go To Next Translated

Marks the current segment as rejected and brings you to the next translated segment. 
(Only translated or approved segments can be marked as rejected.

Tag Verification

Invokes the Tag Verification Tool which verifies if the tags in the source language seg-
ments match the tags in the corresponding target language segments.

Spell Check

Invokes the spell checking tool for the target language of the current project file.

Update Mini-TM

Updates the mini-TM with the source and target language strings in the currently active 
segment. For this function to work, the segment must already be marked as translated. 
This function is used to update the mini-TM after a segment which has already been 
marked as translated has been edited. For more information, see the section Editing 
Translated Segments.

Help

Invokes the online help. This is currently not available, but will be available in a later ver-
sion.

11.1.2 The Status Bar

The status bar of the translation editor provides match information for the matches con-
tained in the match window. For further details on the match information provided, please 
see the section Handling Matches.

The status bar also indicates the id, number and status of the currently active segment 
and the total number of segments in the file e.g. 4/256 indicates that the currently active 
segment is the fourth segment in the file and that there is a total of 256 segments in the 
file.
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11.1.3 The Menus

The menus and menu options provided in the translation editor are explained as follows 
in the order in which they appear in the GUI.

File Menu

New Project...

Allows you to create a new project. For more information on this option see the section 
Working with Projects and Mini-TMs.

Open Project...

Allows you to open an existing project. For more information on this option see the sec-
tion Working with Projects and Mini-TMs.

Open

Opens a file browser where you can select the XLIFF file he or she wishes to open in the 
editor. Only XLIFF files are listed in the file browser.

Save

Saves all modifications made to the file which is currently open in the editor.

Save As

Allows you to save a file under a new name.

Save MIni-TM

Saves the mini-TM which is currently selected.

Close

Closes the .xlz file currently open in the editor. If the file has been modified since it was 
opened, you will be asked if you wish to save the modifications before closing the file.

Print Options

Opens the Print Options dialog where you can specify the format of the print-out of the 
.xlz file.

Print

Exports the .xlz file currently open in the editor to HTML and opens the HTML file in a win-
dow of your default browser from where the file can be printed to a printer.

File History List

This is a list of all XLIFF file previously opened in the editor.

Exit

This closes the editor application. If you have modified a .xlz file and not yet saved it, you 
will be asked if you wish to save the modifications before closing the editor.
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Edit Menu

Undo

Undoes the last editing action. This option only undoes edits made in the target language 
window. However, it does not undo the 'Clear Target' option or the 'Copy Source Tags' 
option. Also, it does not undo the marking of segments as untranslated, translated or 
approved.

Redo

Redoes the last action to which the Undo option was applied.

Cut

Removes the selected text and copies it to the clipboard.

Copy

Copies the selected text to the clipboard,

Paste

Inserts the selected text at the cursor position.

Transfer

Transfers the match currently highlighted in the match window to the target language 
window. The currently active target language segment is overwritten. 

Untransfer

This function of the editor is currently not available. Transfers can be undone by using the 
Undo menu.

Copy Source

Copies the source language segment to the target language window. The corresponding 
target language segment is overwritten.

Copy Source Tags

Copies the tags in the source language segment which are not present in the target lan-
guage segment to the end of the target language segment.

Clear Target

Deletes the target language segment in the target language window, leaving you with a 
blank segment where the translation can be entered.

Mark Segment As - Translated, Untranslated, Approved, Rejected

Marks the currently active segment as Translated, Untranslated, Approved or Rejected. If 
the currently active segment is already translated, only the options Untranslated, 
Approved and Rejected are available for selection. If the currently active segment is 
already approved, only the options Translated and Rejected are available for selection. If 
the currently active segment is untranslated, only the option Translated is available for 
selection. This menu option is also available in the right-click mouse button menu.
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Mark All 100% Matches As - Translated

Marks all 100% matches which are currently marked as approved, as translated. These 
translations are then editable again.

Mark All 100% Matches As - Approved

Marks all 100% matches which are currently marked as translated or rejected, as 
approved. These translations are then write-protected.

Mark All 100% Matches As - Rejected

Marks all 100% matches which are currently marked as translated or approved, as rejec-
ted. 

Mark All Segments As - Translated

Marks all segments as translated.

Mark All Segments As - Approved

Marks all segments which are currently marked as translated or rejected, as approved. 

Mark All Segments As - Rejected

Marks all segments which are currently marked as translated or approved, as rejected. 

Confirm and Translate Next

Marks the currently active segment as translated and brings you to the next untranslated 
segment. This menu option is active only when the currently active segment is marked as 
untranslated.

Approve and Go To Next Translated

Marks the currently active segment as approved and brings you to the next translated 
segment. This menu option is active only when the currently active segment is marked as 
translated or rejected.

Reject and Go To Next Translated

Marks the currently active segment as rejected and brings you to the next translated seg-
ment. This menu option is active only when the currently active segment is marked as 
translated or approved.

Comment on Segment 

Allows you to add a comment to the currently selected segment.

Comment on File

Allows you to add a comment to the XLIFF file. These comments are not linked to a partic-
ular segment.

Search/Replace

Calls up the Search/replace dialog where you can search for text in the source and target 
language windows and replace text in the target language window only.
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View Menu

Toolbar - File, Edit, Navigation, Tools, Help

Allows you to hide the File icons, the Edit icons, the Navigation icons, the Tools icons and 
the Help icon.

Toolbar - Show All

Allows you to show all icons in the toolbar.

Toolbar - Hide All

Allows you to hide the toolbar completely.

Match Window

Allows you to hide or display the match window.

Attributes

Allows you to hide or display the attributes window which contains attribute information 
on the different matches in the match window.  

Source Context

Allows to show or hide the source context information from the translation memory.

Search Bar

Allows you to hide or display the source and target language search files in the GUI.

Tags

This feature is not available in this version. 

Abbreviated Tags

This feature is not available in this version. 

Fonts

Opens a dialog to set the font size for the translation text.

Color

This feature is not available in this version.

Window Arrangement - Side by side

Displays the source and target language windows side by side i.e. Vertically, with the 
source language window on the left and the target language window on the right. This is 
the default setting.

Window Arrangement- Over/under

Displays the source and target language windows above and below each other i.e. Hori-
zontally, with the source language window on top and the target language window on the 
bottom.
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Navigation Menu

Next Segment

Brings you to the next segment with the given status or translation type. For more details, 
see the section Navigation Options.

Previous Segment

Brings you to the previous segment with the given status or translation type. For more 
details on this option, see the section Navigation Options.

Next Multiple 100% Match

Brings you to the next segment for which more than one 100% match is available.

Previous Multiple 100% Match

Brings you to the previous segment for which more than one 100% match is available.

Go To Top

Brings you to the start of the file.

Go To Bottom

Brings you to the end of the file.

Page Up

Move the source and target language windows back one page.

Page Down

Moves the source and target language windows forward one page.

Go to Segment...

Displays the Go to Segment dialog window in which you can enter the number of a seg-
ment. You then click on OK, and the requested segment will appear as the currently active 
segment. 

Tools Menus

Tag Verification

Verifies that the tags in each source language segment match the tags in the correspond-
ing target language segment. For more details, see the section Working with the Tag 
Verification Tool.

Spell Checking

Verifies the spelling in the target language window. This option automatically invokes the 
spell checking dictionary for the target language in the .xlz file. For more details see the 
section Working with the Spell Checking Tool.

Update Mini-TM

Updates the mini-TM with the source and target language strings in the currently active 
segment. For this function to work, the segment must already be marked as translated.
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Maintain Mini-TM

Opens the Maintain Mini-TM dialog where you can edit the contents of a mini-TM. This 
option is available only when no .xlz file is open in the editor. For further details, see the 
section Maintaining Mini-TMs.

Merge Mini-TMs

Opens the Merge Mini-TMs dialog where you can merge two or more mini-TMs to create 
one larger mini-TM. For further details, see the section Merging Mini-TMs.   

Search Mini-TM

Open a Search Mini-TM window which allows the user search in Mini-TM while an .xlz file is 
open

Convert to Original

Converts one or multiple .xlz files back to their original format. This option also allows you 
to create a TMX for each .xlz file during back-conversion. For more details see the section, 
Back-Converting .xlz Files.

Split XLIFF File

This allows you to split a large XLIFF file into a number of smaller ones. For more details 
see the section, Splitting and Merging Large XLIFF Files.

Merge a split XLIFF file

This option allows you to take a bunch of files created by the Split XLIFF File tool, and 
merge them back together into one file. For more details see the section, Splitting and 
Merging Large XLIFF Files.

Options Menu

Update Tags

Updates tags in the target language match segment as it is being transferred to the tar-
get language window, so that the tags in the target language segment match the tags in 
the new source language segment. This option can be switched on or off.

Tag Protection

Switches on or off the tag protection. For more details, see the section Tag Protection.

Synchronized Scrolling

Switches on or off synchronized scrolling. If this option is switched on, when you scroll the 
source or target language window, the other window scrolls in parallel. If this option is 
switched off, when you scroll the source or target language window, the other window 
remains stationary.

Source Write Protection

Switches on or off the write protection in the source language window. 

Ignore Tag Order

If this option is switched on, the order in which the tags occur in a segment is not 
approved when the tag verification tool is used. If this option is switched on, the tag veri-
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fication tool will stop if the order of the tags in the target segment does not match the 
order of the tags in the source segment. For more details, see the section Working with 
the Tag Verification Tool.

Autopropagate

Switches on or off the autopropagate option. For more details, see the section Working
with the Autopropagate option.

Validate XLIFF

Enables or disables validation of XLIFF files on open and save. You should enable this 
option by default, as this ensures correct exchange of files between different tools. In 
case you get some error about “not wellformed XML” when opening a file, you can disable 
this option and try to open the file again.

Autosave

Switches on or off the autosave option. If the autosave option is switched on, a backup 
.xlz file is saved automatically at the specified interval.

Customize Shortcuts

Opens the Customize Shortcuts dialog where you can change existing shortcuts for menu 
options or create shortcuts for menu options which previously had none.

Help Menu

Index

There is currently no online help available.

License

Displays License agreement under which this software is distributed.

About

Provides the version number of the application. 

11.2 Customizing the GUI
It is possible to change the window arrangement in the editor GUI. The default setting for 
the window arrangement is for the source language window and the target language win-
dow to be positioned vertically (side by side), with the source language window on the 
left-hand side and the target language window on the right-hand side. The match window 
at the bottom. In the View menu, the option Window Arrangement allows you to change 
this setting to over/under. This results in the source and target language window being 
displayed horizontally, with the source language window on top and the target language 
window on the bottom.

11.3 Hotkeys and Shortcuts
Hotkeys are available for all menu options. Shortcuts are available for the most commonly 
used menu options and are listed alongside the menu option in the menu in which they 
occur. On the following page is a list of the default shortcuts available in the editor for 
commonly used functions and options.
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File Edit
New Project... Ctrl+N Undo Ctrl+Z
Open Project... Redo Ctrl+Y
Open Ctrl+O Cut Ctrl+X
Save Ctrl+S Copy Ctrl+C
Save As... Shift+Ctrl+S Paste Ctrl+V
Save Mini-TM Shift+Alt+S Transfer Ctrl+F
Close Ctrl+W Untransfer Shift+Ctrl+F
Print Options... Shift+Ctrl+P Copy Source Alt+Insert
Print... Ctrl+P Copy Source Tags Shift+Alt+Ins
Exit Ctrl+Q Clear Target Alt+Delete

Mark Segments:
 … as Translated Alt+1
 … as Approved Alt+2
 … as Rejected Alt+4
 … as Untranslated Alt+3
Mark All 100% Matches:
 … as Translated
 … as Approved
 … as Rejected
Mark All Segment:
 … as Translated
 … as Approved
 … as Rejected
Confirm and Translate Next Alt+Return
Approve and go to Next 
Translated Ctrl+Return
Reject and go to Next 
Translated Ctrl+-
Comment on Segment:
 … Add Comment Ctrl+Alt+N
 … Edit Comment Ctrl+Alt+B
 … Delete Comment Ctrl+Alt+M
Comment on File
Search/Replace F3
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View Navigation

Toolbar: Next Segment
Ctrl+Arrow 
Down

 … File Previous Segment
Ctrl+Arrow 
Up

 … Edit Next Multiple 100% Match

 … Navigation
Previous Multiple 100% 
Match

 … Tools Go To Top Ctrl+Home
 … Help Go To Bottom Ctrl+End
 … Show All Page Up Page Up
 … Hide All Page Down Page Down
Match Window Go To Segment Ctrl+G
Attributes
Source Context Alt+S
Search Bar
Tags
Abbreviated Tags
Fonts...
Color...
Window Arrangement:
 … Side by Side
 … Over/under

Tools Options
Tag Verification Ctrl+T Update Tags
Spell Checking F7 Tag Protection Alt+P
Update Mini-TM Ctrl+U Synchronized Scrolling
Maintain Mini-TM Ctrl+M Source Write Protection
Merge Mini TMs Shift+Ctrl+M Ignore Tag Order
Search Mini-TM Alt+Q Autopropagate
Convert To Original... Validate XLIFF
Split XLIFF file... Autosave...
Merge a split XLIFF file... Spellchecker Options...

Customize Shortcuts...

Help
Index...
License...
About

11.4 Customizing Shortcuts
It is possible to change the default shortcuts and to create shortcuts for menu options 
which previously had no shortcuts. To do so, click on Options - Customise Shortcuts. The 
Customise Shortcuts dialog appears (see Fig. 21).

The names of all menus are listed in the Menus window. If you click on a menu name, the 
options available in this menu appear in the Menu Options window. If there is a shortcut 
already available for the selected menu option, it will appear in the Current Shortcut field. 
If there is no shortcut available, this field will be empty.
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To enter a new shortcut or change an existing shortcut, position the cursor in the New 
Shortcut field and press the keys which you would like to use as the shortcut. For 
example, if you would like your new shortcut to be Shift+X, press the shift key and the 
'x' key simultaneously, and 'Shift+x' should appear in the New Shortcut field. To apply this 
shortcut, click on the Set button. The new shortcut is transferred to the Current Shortcut 
field. The new shortcut is now saved.

Note: If you try to use a shortcut which already exists, you will receive a warning  
message asking you to choose a different shortcut. 

To return to the default shortcut, click on the Reset button. This deletes the new shortcut 
and replaces it with the original, default shortcut. To reset all shortcuts to their original, 
default setting, click on Reset All. If you want to delete a shortcut, click on No Shortcut. 
To close the dialog, click on Close. 
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12 Appendix

Note: Most of the chapters in the appendix have been moved here, as they rely on  
unmaintained functionality in OLT or on the translation work flow as it used to  
be at Sun when the editor was open sourced. These chapters are kept for  
information but need larger rework (not only in documentation but also in the  
implementation of the application).

12.1 Common Translation Process
In our suggested translation process, the source files (HTML, SGML, XML, .po etc.) are first 
segmented or broken up into sentences and then converted to the internal format of 
these tools, XLIFF.

Using the system involves the use of two or three tools, the Open Language XLIFF Filters, 
an optional translation memory server-side tool (TM tool) and the Open Language Tools 
XLIFF Translation Editor. The server side tool is not yet available as part of the Open Lan-
guage Tools project, but hopefully will be added in the future. The following describes the 
process used in the translation of files in the supported formats.

After the source files have been converted to XLIFF, the TM tool compares each segment 
in each source file against each source language segment in the translation database. 
Leveraging attributes may be used to confine this search to segments from particular pro-
jects, product groups etc. If the new source segment is identical to an old source segment 
in the database, this is referred to as a 100% match. If the new source segment is at least 
75% similar but not identical to an old source segment in the database, this is referred to 
as a fuzzy match.

The .xlz file contains all of the source segments from the original file and any matches 
found for each of these segments in the translation database. It also contains the format-
ting of the original source file so that the translated .xlz file can be converted back to its 
original format. 

The translation of .xlz files is completed in the Open Language Tools XLIFF Translation 
Editor. Once translation has been completed, the .xlz files are converted back to their ori-
ginal format using the back-conversion tool which is integrated into the editor.

The back-conversion tool produces a file in the original source format (HTML, SGML, XML 
etc.) for each .xlz file. During back-conversion it is also possible to create a TMX file for 
each .xlz file. This TMX file contains all of the source and target segments from the .xlz 
file. These TMX files are used to update the central translation database at the end of 
each project.

12.2 Attribute Information
All matches contained in the Sun translation database are assigned attributes indicating 
the origin of the match. A list of all attributes is provided below. The attribute information 
associated with each match in the .xlz file is contained in the .xlz file. If you wish to view 
this attribute information, go to the View menu and switch on the Attributes option. An 
extra window will appear below the match window, and any attribute information will be 
displayed in this window (see Fig. 21). If there is not enough room to display all of the 
attribute information in the attribute window, a scrollbar will appear on the right-hand 
side of this window, which allows you to scroll down through the window and view all 
attributes.

The attributes associated with a match vary depending on the origin of the match. For 
example, some attributes are used only for matches originating in SGML project, while 
others are used only for matches originating in Star Office projects. Therefore, some 
matches may have more attribute information than others.
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Note: Attribute information is provided only for matches from the Sun translation  
database. No attribute information is provided for matches from the mini-TM  
of the Translation Editor. The status bar indicates if a match has come from  
the Sun translation database or the mini-TM.

A list of all possible attributes is as follows. 

Project ID 

This is an ID field that represents the project that the segments are associated with. Every 
localisation project at Sun has a project ID.
Workspace / Build 

This attribute applies to Star Office projects only. This is an identifier for a 
workspace/build to which the segment pairs in a TMX file belong. 

Module 

This attribute applies to SOffice projects only. This is an identifier for the Soffice module to 
which the segment pairs in a TMX file belong.

Short Book Name 

This attribute applies to documentation files only. This is the short book name of the book 
that the document comes from. It applies to SGML documents only and can be ascer-
tained from pubstool.
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Subject Area 

This attribute indicates the subject area of a segment i.e. the general style of writing. Ini-
tially, there will be five subject areas which are listed as follows.

• Education

• Marketing

• Legal

• Operating Systems & Apps - software messages

• Operating Systems & Apps - documentation

Part No.

This attribute applies to documentation files only. This is the part number of the book that 
the document comes from. It applies to SGML documents only.

Version Identifier

This sets the version identifier string for each target segment. Within a project, there may 
be several updates to a file. This attribute allows users to track the translations of seg-
ments from different updates. And so the segments from the first translated version of 
the file could have the version identifier "1", while the translations from the first update to 
that file could have the version identifier "2" etc. When matches are returned by the TM 
tool, the user can then easily establish which update each translation came from.

File Identifier

This is a unique identifier for a file or file-like object. It can be a full path, or a URL, or 
some other such identifier. While it is technically possible for the user to specify a value 
for this attribute, it is highly unlikely for this to be necessary, as the file identifier is spe-
cified by default in the header of any TMX file created by the Sun translation tools. This 
value is automatically applied to all segments in the file during import. This file identifier 
overrides any file identifier which is specified by the user. However, if the user imports a 
TMX file which has not been generated by the Sun translation tools and therefore may not 
contain this file identifier information, the user can use this attribute to specify the file 
identifier to be applied to all the segments in the file.

Format Type

This is the format of the original file from which the TMX file was created e.g. HTML, XML. 
While it is technically possible for the user to specify a value for this attribute, it is highly 
unlikely for this to be necessary, as the format type is specified by default in the header 
of any TMX file created by the Sun translation tools. This value is automatically applied to 
all segments in the file during import. This format type overrides any format type which is 
specified by the user. However, if the user imports a TMX file which has not been gener-
ated by the Sun translation tools and therefore may not contain this format type 
information, the user can use this attribute to specify the format type to be applied to all 
the segments in the file. 

Component Type

This attribute applies to SOffice projects only. This is the type of component in which a 
segment occurs. This attribute information is already provided in the file presented for 
translation and travels with the segment through the translation process. Therefore, it 
does not need to be specified by the user. The following values are permitted:
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• software

• help

• extras

Text Type

This attribute applies to Star Office projects only. This attribute information is already 
provided in the file presented for translation and travels with the segment through the 
translation process. Therefore, it does not need to be specified by the user. The following 
values are permitted: 

• quickhelp 

• title 

• menu 

• menuitem 

• define 

• other

Import Time

Each target string imported into the database is automatically stamped with the date and 
time of when it was imported.

12.3 1:1 and M:N matches
A match is classified as either a 1:1 (one to one) or M:N (many to many) match. Most 
matches are 1:1 matches. This means that the match found in the database comprises 
one source language segment and one corresponding target language segment. 

However, M:N matches may also occur. M:N matches are generated at the alignment 
stage. The Sun Translation Alignment tool is capable of recognizing that two or more seg-
ments in the source language may have been translated using one or more segments in 
target language. 

When searching for matches, the Sun Translation Memory System may find a M:N match 
for a segment. For example:

• New source segment 1: Today is Monday.

• New source segment 2: The sun is shining.

M:N match found for segment 1 & 2:

• Old source: Today is Monday. The sun is shining.

• Old target: Heute ist Montag, und die Sonne scheint.

In the case of the M:N match, two segments in the source language have been translated 
using one segment in the target. 

This M:N match would not have been found by the TM tool if the second new source seg-
ment were, for example, “It's very windy.”, as the similarity between the two new source 
segments and the M:N match would have been less than 75%. However, if the second 
new source segment were, for example, “The sun was shining.”, the M:N match would 
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have been found by the TM tool, as the similarity between the two new source segments 
and the M:N match would have been greater than 74%.

If a M:N match is highlighted in the match window, the editor will automatically highlight 
all of the segments in the source language window to which this match applies. All source 
segments to which the match applies are displayed in the match window. The Transfer 
1:1 button beside the match window is renamed automatically to Transfer M:N. In addi-
tion, the source language icon in the match window changes from  to  to indicate 
that this is a M:N match. 

12.4 Dealing with SGML Marked Sections
This section explains how the Editor handles SGML marked section formatting, when such 
formatting is displayed in the Editor, and the issues that exist in the current release of the 
Editor, with marked section handling.

12.4.1 What is a Marked Section?

A marked section is a piece of SGML text, that is surrounded by marked section delim-
iters. The start delimiter is, '<![ {label} [', where '{label}' is either 'INCLUDE', 'IGNORE', 
or a parameter entity that resolves to INCLUDE' or 'IGNORE'. The closing delimiter is ,']]>'. 
If the label for a marked section is 'INCLUDE' or a parameter entity that resolves to 
'INCLUDE', then the marked section is called an included marked section. If the label for a 
marked section is 'IGNORE' or a parameter entity that resolves to 'IGNORE', then the 
marked section is called an ignored marked section.

12.4.2 Which Marked Sections Show Up in the Editor?

The behavior around what is hidden, or displayed in the editor, is determined by the 
scope of the marked section. There are three scenarios:

1.If the marked section is inline, i.e., included with text text of the book, inside a <para> 
tag, for example, then it is always displayed in the editor.

2.If the marked section is at a block level scope, and the marked section is included, then 
the marked section identifiers do not appear in the Editor, but the content of the marked 
section will. For example:

<![ %IA; [ 

        <para>This is a paragraph that applies to the Intel Architecture. There  will be a 
lot more of these from now on. </para> 

]]>

In this case the '<![ %IA; [' and ']]>' will not display in the editor, but the two seg-
ments inside, will. The marked section delimiters will go into the skeleton file (a hidden 
subsection of the XLZ file).

3.If the marked section is at a block level scope, and the marked section is ignored, then 
the entire marked section, including its contents goes in to the skeleton file, and is not 
visible.

12.5 The Structure of .xlz Files 
The Open Language Tools XLIFF Translation Editor is designed to read .xlz and .xlf files 
generated by the Open Language Tools XLIFF Filters.

An .xlz file is a zip file containing two files – a content.xlf file and a skeleton.skl file. The 
content.xlf file is in XLIFF format, and contains all of the translatable strings and inline 
formatting from the original source file. It also contains any matches found for these 
strings in the translation database. In addition, it contains word count information for  
each segment to be translated and any context information that was found in either the 
translation database, or the source file (e.g. software message file comments). The skel-
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eton.skl file contains all of the structural formatting information from the original source 
file. The skeleton.skl file must travel with its corresponding content.xlf file at all times. For 
this reason, both files have been zipped to form one .xlz file.

The Open Language Tools XLIFF Translation Editor is capable of reading both .xlz and .xlf 
files. However, it is recommended that you do not unzip the .xlz files, as this ensures that 
the content.xlf and the skeleton.skl never become separated from each other.

The internal format used in the content.xlf file is called XLIFF – XML Localisation Inter-
change File Format. XLIFF is on the way to becoming a standardised format used by the 
localisation industry. For further information, see:

http://www.oasis-open.org/committees/xliff/documents/xliff-specification.htm.

The fact that the .xlz file contains all of the matches found for a particular file in the data-
base means that there is no need to send a large database to translators with each set of 
project files. All that the translators need is the .xlz files and the Open Language Tools 
XLIFF Translation Editor assuming that file has already been run against the database 
contents.

The internal structure of the content.xlf file contained in the .xlz file is shown in the fol-
lowing example:

<?xml version="1.0" ?>
<!DOCTYPE xliff PUBLIC "-//XLIFF//DTD XLIFF//EN"
 "http://www.oasis-open.org/committees/xliff/documents/xliff.dtd" >

<xliff version="1.0">

<file source-language="en-US" datatype="HTML" original="heroes.html" 
target-language="fr-FR">

<header><skl><external-file href="skeleton.skl" /></skl></header>

<body>

<trans-unit id="a1">    
  <source>iForce Initiative</source>
  <count-group name="word count">
    <count count-type="word count" unit="word">2</count>
  </count-group>
  <alt-trans tool="Sun Trans" match-quality="100">
    <source>iForce Initiative</source>
    <target xml:lang="fr-FR">Initiative iForce</target>
    <prop-group name="format penalty">
      <prop prop-type="format-diff-penalty">0</prop>
    </prop-group>
  </alt-trans>
</trans-unit>

</body>
</file>
</xliff>

You can see from the above example that the original English segment is listed first fol-
lowed by the match or matches found for that segment in the database (in the above 
example only one match was found for the segment in question). Fortunately, the Open 
Language Tools XLIFF Translation Editor renders this structure in a user-friendly format, 
showing the source and target segments and any matches pertaining to these segments 
in three separate windows.
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12.6 Back-Converting .xlz Files
To convert .xlz files back to their original format, select the Convert to Original option in 
the Tools menu. The Convert to Original dialog appears (see Fig. 22).

If a .xlz file is currently open in the editor, the path and filename appear automatically in 
the Source File/Dir field. If you wish to select another file or directory, click on the Browse 
button beside the Source File/Dir field to select either a single .xlz file or a directory of .xlz 
files which you wish to convert back to the original source format. (The directory you 
select may contain subdirectories.) If there is no .xlz file currently open in the editor, the 
directory from which an .xlz file was last opened appears automatically in the file browser.

In the Encoding dropdown list select the codeset you wish to use in the back-converted 
file. The default setting is UTF-8. Click on the Browse button beside the Copy File(s) to 
field to select the directory to which the back-converted files should be written. If you do 
not specify any directory here, the back-converted files will automatically be written to 
the directory where the .xlz files are located.

Note: If no target translation exists for a segment in the .xlz file, the original English  
segment is inserted in its place in the back-converted file. It is very important  
that all segments are marked as translated before back-conversion, to ensure  
a fully translated, output file.

The Create TMX Files option allows you to create a TMX file during back-conversion. A 
TMX file is created for each back-converted .xlz file. The TMX file contains all of the source 
language segments and their corresponding target translations from the .xlz file. TMX 
files must be returned to Sun at the end of each project so that the central Sun transla-
tion database can be updated with the latest translations.
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Note: TMX files are created only if all of the segments in the .xlz file have been 
marked as translated or marked as approved. This ensures that TMX files  
cannot be created until a file has been fully translated. If a .xlz file contains  
some segments which have not been marked as translated, an error message  
will appear during TMX file creation indicating the file name and stating that  
the file contains segments which have not been marked as translated. Should  
this error message appear, simply open the .xlz file in the editor, ensure that  
the translation of the file is complete, mark all segments as translated, and  
then try creating the TMX file again.

The user can also select option to overwrite existing original files. If this option is not 
selected files with unique names will be created

The user select the option ‘Use file name stored in the .xlz file name’ to backconvert 
the .xlz files to the file with the same name as the original file from which the .xlz file has 
been created or if the option is not selected, the file is backconverted to file whose name 
is determined from the name of the .xlz file

Before back-converting a .xlz file, the editor first checks to see if the .xlz file has been 
saved. If not, you are asked if you wish to save the file before back-converting. If you 
choose No, the last saved version of the file is back-converted.

12.6.1 Using custom Unicode to Entity mapping for SGML

For SGML document format, it's possible to specify custom mapping between Unicode 
characters and entities. The backonverter then uses these settings for the the final docu-
ment.

The typical usage scenario could look like this:

• The user selects SGML tab in Backconversion window

• checks 'Use Custom Mapping' 

• clicks 'Add Mapping'. A new row will appear in the table.

• Either:

• clicks sthe second column and enter the hexadecimal code (for example 201D 
for right upper double quotes) 
or:

• clicks the first column and enter directly the charatcter (if it's available from key-
board).

• click the third column and enter the entity name without & and ; chars surrounding 
the entity.

It's also possible to exclude some of the mappings by selecting 'Default mapping...' and 
then by checking 'Exclude' column for each entity mapping desired to be omitted during 
backconversion. 
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